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1 Overview

This chapter covers the following topics:

e OVPI and ping tests: putting results in context
e Enhancements in version 4.1

e Brief description of reports

e Action Poller — a unique collection mechanism
e Error messages in trend.log

¢ Integration with Network Node Manager

e Ways to customize Cisco Ping reports

e Sources for additional information

OVPI and Ping Tests: Putting Results in Context

Latency and reliability are common ways to measure network performance. If latency is low,
packets are moving from source devices to destination devices as quickly as possible. If
reliability is high, packets are reaching their intended destination. The conventional approach
to measuring latency and reliability is to conduct ping tests and watch for poor results. The
problem with this approach is that the surrounding network is hidden from view. You may
have test results, but are your test results conclusive?

The purpose of the Cisco Ping Report Pack is to add context to latency and reliability
measurements by revealing the surrounding network. With the surrounding network in view,
you have a much better picture of the conditions behind high latency and low reliability. In
addition, you will no longer have to guess what the load on an interface is. You will know
whether the load on the source router interface and the load on the destination router
interface are about the same or completely different.

The Cisco Ping Report Pack will also enhance SLA monitoring capability. If latency breaches a
threshold while utilization is high, the report pack qualifies this event as a non-SLA breach. If
latency or reliability crosses a threshold while utilization is low, the report pack qualifies this
event as an SLA breach.

Enhancements in Version 4.1

Version 4.1 includes new features, a new upgrade package, and defect fixes. For details about
the enhancements that were made to previous releases, see Appendix A, Version History.



New Features

e  Supports Management Console > LIR Configuration
e Supports Management Console > Copy Policy Manager

e Rate data removed from NRT reports, top leve table

New Upgrade Package
e UPGRADE_Ping MIB._to_41.ap

Defect Fixes

e QXCR1000221971
e QXCR1000412603

Briet Description of Reports

Following is a brief description of the reports in Cisco Ping.

Executive Summary. Daily and hourly performance across all pairs. Displays aggregates for
the 95th percentile Round Trip Time and the Packet Delivery Ratio.

Forecast. Ranks the worst performing pairs by daily 95th percentile Round Trip Time or by
total daily Packet Delivery Ratio. Drill down to baseline values, a daily summary, and
projections for F30, F60, and F90.

Worst Performing Pairs. Ranks pairs by daily 95th percentile Round Trip Time and by
Packet Delivery Ratio. Drill down to see interface utilization and CPU utilization for the
previous day.

Daily QuickView/Daily Snapshot. Ranks node pairs by RTT and delivery and provides
analysis of recent RTT and recent delivery; shows rolling baseline and rolling F30 forecast.
Drill down to hourly interface and CPU utilization.

Threshold Near Real Time QuickView/Threshold Near Real Time Snapshot. A rolling
summary of the previous six hours showing 95th percentile Round Trip Time and Packet
Delivery Ratio. Drill down to interface and CPU utilization.

Threshold Daily QuickView. Ranks node pairs by threshold breaches, shows recent Packet
Delivery Ratio, recent Round Trip Time, and compares rolling baseline to rolling F30
calculations. Drill down from summary information to hourly utilization data.

Threshold Summary Daily/Threshold Summary Monthly. Provides daily and monthly
totals for threshold breaches for every node pair. Shows threshold settings, exception details,
SLA qualifications in effect at the time of the exception; tracks changes in the daily SLA
threshold count and daily non-SLA threshold count for the last 30 days.
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Action Poller: A Unique Collection Mechanism

Most report packs use a collection mechanism that collects data from single nodes. This
collection mechanism is built into OVPI and it operates transparently. The Cisco Ping Report
package is different. It has its own collection mechanism—the Action Poller—that collects
data from pairs of nodes as opposed to single nodes. Before collection can take place, you must
define node pairs using the Action Poller User Interface.

Guidelines for a Successful Collection

>»

Action Poller collections are governed by the following rules and restrictions:

¢ A node pair consists of a source node and a destination node. Source and destination
nodes must be discovered. Source and destination nodes that have been discovered will be
filtered by the Action Poller User Interface into lists for selection.

e The source node must be a Cisco router that supports the Cisco Ping MIB or is currently
running the Cisco Ping agent, IOS 10.2 or later.

¢ The write community string for the source node must be correct.

¢ The Action Poller will perform an SNMP set on the source node. If the SNMP set fails, the
node pair collection will fail.

e The destination node must be an SNMP device.

e Any node that is unreachable, unavailable, or not properly configured will generate an
error message in the {DPIPE_HOME} \OVPI\log\trend. log file.

Re-indexing events that affect the interfaces on a device should be tracked through the
datapipe that is being used to inherit node instance information. Analyze and track these
events as necessary.

MIBs and Metrics

Overview

Every polling cycle, the Action Poller collects ping statistics once and interface and CPU
statistics twice. The sequence is:

1 Collect interface and CPU utilization data.
2 Collect ping test data.

3 Collect interface and CPU utilization data.
The Action Poller collects data from the following MIBs:
¢ (Cisco Ping MIB

e (Cisco System MIBlet

¢ Interface Reporting Basic Info MIBlet

The Action Poller returns the following metrics:
e Average round trip time

¢ Minimum round trip time

e Maximum round trip time

e Packet delivery ratio



e Interface utilization

e CPU utilization

The following factors influence the metrics returned by the Action Poller:
e CPU load on the source node

¢ CPU load on the destination node

e Competing user traffic on node interfaces

e Packet size

e Network configuration

e Network load

By configuring Cisco Ping MIB parameters and the frequency of polling, you can collect
metrics that simulate the delay experienced by user traffic between node pairs. By correlating
delay samples with other metrics, you can determine which factors are contributing to delay.

) You cannot set various Ping MIB parameters on the source node or initiate pings unless the
write community string is correctly specified. Use Polling Policy Manager to modify the write
community string on specific nodes.

Packet Delivery Ratios

A source node that supports a ping MIB can be instructed (by means of SNMP SET requests)
to send a defined series of ping messages to a destination node. The source node logs the
following metrics:

e Number of attempted pings
e Number of successful pings
¢ Round trip delay (min, max, and average) for successful pings

If the number of successful pings is less than the number of attempted pings in the ping
sequence, one of the nodes in the node pair, or possibly the network in between, discarded the
ping request or the returning ping response. Several factors can cause a ping to be
unsuccessful:

e Network delay that exceeds the configured ping timeout on the source node
e High CPU load on either the source or destination node

e High traffic loads on the interfaces and/or sub-interfaces of either the source or
destination node competing with the ping traffic

e Packet size—larger packets are more susceptible to discard

¢ The network configuration—traffic management, buffer sizes, and line speeds, among
other factors

e Network load—congested links, congested switching, and routing resources

Factors that influence network delay can also influence the network discard rate. In general,
depending on how the network is configured to handle queuing and traffic management,
overutilization of bandwidth or processing resources can cause delay and discards.

By configuring the Cisco Ping MIB parameters and sampling frequency, you can collect
metrics that represent the general delivery/discard characteristics of the traffic between node
pairs. You can also correlate packet delivery ratios with other metrics, such as CPU load or
buffer size, and determine why packets are being discarded.
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Route Availability

If no ping in a given sample is successful, then (1) connectivity between the source and
destination node was unavailable or (2) the destination node was unavailable when the test
took place. An unavailable route can be caused by any of the following:

e Network configuration error—routing, firewalls, proxies, and so on
¢ Chronic network congestion—packet discard ratio at 100%

e Network/PVC failure

¢ Remote node is down

By configuring Cisco Ping MIB parameters and the frequency of sampling, you can collect
data to compute representative availability on the routes between node pairs. You can also
routinely poll the source and destination nodes at the time of the ping sampling. This will tell
you whether nodes, or the network between the nodes, is causing an availability problem.

Error Messages in trend.log

Not all of the errors that appear in trend. log are error messages. The following messages
contain supplemental information only and can be ignored:

e Messages produced during package installation that refer to tables that are dropped and
then recreated. If a table does not exist, and there is an attempt to drop the table, a
message will be generated.

e Messages produced when the object SQL script attempts to load certain database objects
that have already been loaded by the Common Property Tables package.

e Messages produced during each polling cycle.
Here are a few examples of messages written during each polling cycle:

2004-03-15 14:30:59:000, Eastern Standard

Time, -5:00,bcpfile, ,ERROR,2572,2668,0, "DB_ERR 0, OS_ERR 0, SEVERITY 0, SPID O,
dbErrStr [DataDirect] [ODBC Sybase Wire Protocol driver]No upload tables exist,
using original table Risco_ping_rtd_, osErrStr 01000"

2004-03-15 14:30:59:000, Eastern Standard
Time,-5:00,bcpfile, ,ERROR,2572,2668,0, "Failing command"

2004-03-15 14:30:59:000, Eastern Standard
Time,-5:00,bcpfile, ,ERROR,2572,2668,0, "{call dsi_lock_upload_table_p(?, ?, ?, ?,
?) 1"

Integration with Network Node Manager

Overview

You can improve your ability to isolate faults and diagnose problems by integrating OVPI
with NNM. Integrating NNM and PI entails running a script on NNM and lauching the
Integration Wizard on PI. (Until recently, it was necessary to install integraton software on
NNM and PI. Those software packages are now built into each product.)

If NNM and OVPI are integrated, you should install the optional thresholds sub-package that
comes with Cisco Ping. Installing the optional thresholds sub-package supplies default
thresholds for Round Trip Time, Discards, CPU, and Interface to the Thresholds Module. The
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Thresholds Module monitors the database for threshold conditions and responds to a breach
by taking an action in accordance with category, severity, and destination parameters. The
default response is to send a breach trap to NNM. The breach trap received by NNM becomes
an alarm in the NNM alarm browser, and you can respond to that alarm by launching a Cisco
Ping Near Real Time report.

) Even if you are using the alarms browser, and not seeing alarms from a device that Cisco
Ping is monitoring, you can investigate a device that Cisco Ping is monitoring by opening the
Report Launchpad window and selecting a Cisco Ping report.

Configuring the Thresholds Module is not necessary. You do not need to define an action or
specify a destination for breach traps. However, you are free to modify category, severity, and
destination parameters at any time. For details about these options, refer to the Thresholds
Module User Guide.

Ways to Customize Reports

Reports can be customized by importing customers and locations, applying group filters,
editing parameters, and editing tables and graphs. While group filters allow service providers
to share reports with customers, any user can apply constraints to a report or edit tables and
graphs. For details about view options for tables and graphs, see Appendix B, Editing Tables
and Graphs.

Group Filters

If you want to share reports with customers, you must produce customer-specific reports.
Producing customer-specific reports involves the following steps:

e Importing customers and locations using Common Property Tables
¢ Creating a group account for all of the users affiliated with a particular customer
e Creating a group filter for the group account

For more information about group filters, refer to the OVPI Administration Guide.

Editing Parameters

Editing a parameter applies a constraint to the report. The constraint filters out data you do
not want to see. For example, if you edit the Customer Name parameter, data for every
customer except the customer you typed in the Customer Name field will drop from the
report. Cisco Ping supports the following parameters:

e (Customer Name
e (Customer_Id

e Location_ Name
e TLocation_Id

e  Source

e Destination
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If you are using the Web Access Server to view reports remotely, edit parameters by clicking
the Edit Parameters icon at the bottom right-hand corner of the report. When the Edit
Parameters window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click the Current Value field. Type a new value and
click OK.

Sources for Additional Information

Overview

This user guide provides samples of some of the reports in the Cisco Ping Report Pack. The
demo package that comes with Cisco Ping contains a sample of every report in the package. If
you have access to the demo package and you want to know what fully-populated reports look
like, install the demo package. Like real reports, demo reports are interactive. Unlike real
reports, demo reports are static.

For information regarding the latest enhancements to the Cisco Ping package and any known
issues, refer to the Cisco Ping Report Pack Release Notes. You may also be interested in the
following documents:

e [Interface Discovery Datapipe User Guide
e Thresholds Module User Guide
e NNM/PI Integration User Guide

Manuals for OVPI, and manuals for the reporting solutions and shared packages that run
on OVPI, can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report
packs and datapipes are listed under Performance Insight Report Packs. Each entry includes a
date. If a manual is revised, the date will change. Since revised manuals are posted on a
regular basis, you should compare the date on your PDF against the date of the PDF on the
web and download the web edition if it is newer.
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2 The Upgrade Install

This chapter covers the following topics:

¢  Guidelines for a smooth upgrade

e Using Package Manager to install the upgrade package
¢  Uninstalling Cisco Ping

Guidelines for a Smooth Upgrade

The report pack CD contains report packs, datapipes, and shared packages. When you insert
the CD and launch the package extraction program, the install script extracts every package
from the CD and copies the results to the Packages directory on your system. After the extract
process finishes, you will be prompted to start Package Manager. Before using Package
Manager, review the following guidelines.

Prerequisites for the Upgrade

The following software must already be installed before upgrading to Cisco Ping 4.1:
e (OVPI5.2

e Any and all service packs available for version 5.2

e (Cisco Ping Report Pack 4.0

e Interface Discovery Datapipe 2.4

¢ Interface Reporting ifEntry Datapipe 2.4

You can find information about each service pack for OVPI, including installation
instructions, in release notes for the service pack.

Distributed Environments

If you are running Cisco Ping in a distributed environment, the central server, every satellite
server, and every remote poller must be running OVPI 5.2 Following is an overview of the
procedure for upgrading Cisco Ping in a distributed environment:

1 Disable trendcopy on the central server.

2 Ifyou are running version 2.2 or earlier of the Interface Reporting Datapipes, remove
them.

3 Install UPGRADE_Ping MIB_to_41; deploy reports.

4 Install these packages simultaneously:
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5

6

e (Cisco Ping Thresholds sub-package (optional)

e Interface Reporting ifEntry Datapipe 2.4 (if removed version 2.2 or earlier)
OR
UPGRADE_IRifEntry_Datapipe_to_24 (if version 2.3 is installed)

¢ Interface Discovery Datapipe 2.4 (if removed version 2.2 or earlier)
OR
UPGRADE_IFEntry_Disc_Datapipe_to_24 (if version 2.3 is installed)

For each satellite server:
a Remove version 2.2 or earlier of the Interface Discovery Datapipe.
b Install UPGRADE_Ping MIB_to_41.
c¢ Install these packages simultaneously:
— Cisco Ping Thresholds sub-package (optional)

— Interface Reporting ifEntry Datapipe 2.4 (if removed version 2.2 or earlier)
OR
UPGRADE_IRifEntry_Datapipe_to_24 (if version 2.3 is installed)

— Interface Discovery Datapipe 2.4 (if removed version 2.2 or earlier)
OR
UPGRADE_IFEntry_Disc_Datapipe_to_24 (if version 2.3 is installed)

Enable trendcopy on the central server.

7 You must reconfigure your central and satellite servers. See Configuring Servers in a

Distributed System on page 27 for more information.

Converting Threshold Breaches into Alarms

If OVPI and NNM are integrated, you should install the optional thresholds sub-package,
Ping_MIB_Threshold, on the OVPI server. If you install the thresholds sub-package, OVPI
will respond to a threshold breach by sending a breach trap to NNM, where the trap displays
as an alarm in the NNM alarm browser.

The thresholds sub-package cannot operate unless the Threshold and Event Generation
Module, commonly known as the Thresholds Module, is also installed. If you are not running
any version of the Thresholds Module, Package Manager will install the latest version for you,
automatically.

Upgrading fo Cisco Ping 4.1

Perform the following tasks to upgrade Cisco Ping:

Task 1: Stop OVPI Timer and extract packages from the report pack CD

Task 2: Uninstall any old version (2.2 or earlier) of the Interface Reporting Datapipes
Task 3: Install the Upgrade Package

Task 4: Install the Thresholds Sub-Package and restart OVPI Timer
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Task 1: Stop OVPI Timer and extract packages from the report pack CD

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays
automatically; on UNIX, mount the CD if the CD does not mount automatically, navigate
to the top level directory on the CD, and run the . /setup command.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the extract is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

After the copy to the Package directory is complete, you can navigate to the Packages
directory to see the results. Under the Ping MIB folder, you will see the following folders:

Cisco_Ping.ap
Cisco_Ping_Demo.ap
Cisco_Ping Thresholds.ap
UPGRADE_Ping MIB_to_41.ap

Installing the demo package is optional. You may install the demo package by itself, with no
other packages, or you may install the demo package along with everything else.

Task 2: Uninstall any old version (2.2 or earlier) of the Interface Reporting Datapipes

1

2
3
4

7

Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeploy window opens.
Click the check box next to the following packages:
IFEntry_Disc_Datapipe
IR_ifEntry_Datapipe
Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal begins. When the uninstall
process is complete, a package removal complete message appears.

Click Done to return to the Management Console.

Task 3: Install the Upgrade Package

1

2

The Upgrade Install

From the Management Console, select Tools > Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.
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Task 4:

Click Install. Approve the default installation directory or select a different directory if
necessary.

Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the OVPI Application Server.

Click Next. The Package Selection window opens.
Click the check box next to the following package:

UPGRADE _Ping MIB_to_41

IR_ifEntry_Datapipe 2.4

or

UPGRADE _IRifEntry_Datapipe_to_24

IFEntry_Disc_Datapipe 2.4

or

UPGRADE _IFEntry_Disc_Datapipe_to_24
Click Next. The Type Discovery window opens. Disable the default.
Click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

10 Click Done.

Do not be surprised if the UPGRADE package you just installed has
disappeared from Package Manager. Package Manager will display what you
just installed as Cisco Ping 4.1.

Install the Thresholds Sub-Package and restart OVPI Timer

o O A WN

~N

Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Install.
Click Next. The Report Deployment window opens; disable the option to Deploy Reports.
Click Next. The Package Selection window opens.
Click the check box next to the following packages:
Cisco_Ping_Thresholds
Click Next. The Type Discovery window opens.
Disable the default and click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

10 Click Done to return to the Management Console.
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11 Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Package Removal

Follow these steps to remove the Cisco Ping Report Pack.
1 Log in to the system. On UNIX systems, log in as root.
2 Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b  Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.

Click Next. The Report Undeployment window opens.

N OO0 0 AW

Click the check box next to the following packages:
Cisco_Ping
Cisco_Ping_Thresholds (if installed)
Cisco_Ping_Demo (if installed)

8 Click Next. The Selection Summary window opens.

9  Click Uninstall. The Progress window opens and the removal begins. When the removal
finishes, a package removal complete message appears.

10 Click Done.
N Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.

b  Select OVPI Timer from the list of services.

The Upgrade Install
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¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install

This chapter covers the following topics:
¢ Guidelines for a smooth installation
¢ Installing Cisco Ping

e Accessing deployed reports

¢  Uninstalling Cisco Ping

Guidelines for a Smooth Installation

An OVPI reporting solution has at least two ingredients, a report pack and a datapipe. Some
reporting solutions offer multiple datapipes. When you install a datapipe, you configure OVPI
to collect a specific type of performance data at a specific interval. When you install a report
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

When you insert the report pack CD and launch the package extraction program, the install
script extracts every package from the CD and copies the results to the Packages directory on
your system. After the extract process finishes, you are prompted to start the Package
Manager install wizard. Before using Package Manager, review the following guidelines.

Prerequisites for Package Installation

The following software must be installed before installing Cisco Ping:
e (OVPI5.2

¢ Any and all service packs available OVPI 5.2

e Interface Discovery Datapipe 2.4

You can find information about each service pack, including installation instructions, in the
release notes issued with the service pack. The Interface Discovery Datapipe is a prerequisite
for the IR ifEntry Datapipe. If you are running version 2.2 or earlier of the IR ifEntry
Datapipe, uninstall the old version and install the latest version. If you are running version
2.3 of the IR ifEntry Datapipe, install the upgrade package.

Distributed Environments

If you are running Cisco Ping in a distributed environment, the central server, every satellite
server, and every remote poller must be running OVPI 5.2. Following is an overview of the
procedure for installing Cisco Ping in a distributed environment.
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Central Server

1 If you are running version 2.2 or earlier of the Interface Discovery Datapipe, remove it.
2 Install the following packages simultaneously:
e (Cisco Ping; deploy reports
e (Cisco Ping thresholds sub-package (optional)
e Interface Reporting ifEntry Datapipe 2.4 or UPGRADE_IRifEntry_Datapipe_to_24
¢ Interface Discovery Datapipe 2.4 or UPGRADE_IFEntry_Disc_Datapipe_to_24

Each Satellite Server

1 Ifyou are running version 2.2 or earlier of the Interface Discovery Datapipe, remove it.
2 Install the following packages simultaneously:
e (Cisco Ping
e (Cisco Ping thresholds sub-package (optional)
e Interface Reporting ifEntry Datapipe 2.4 or UPGRADE_IRifEntry_Datapipe_to_24
e Interface Discovery Datapipe 2.4 or UPGRADE_IFEntry_Disc_Datapipe_to_24

Seeing Threshold Breaches as NNM Alarms

If OVPI and NNM are integrated, you should install the optional thresholds sub-package,
Cisco_Ping_Threshold. If you install the optional thresholds sub-package, OVPI will respond
to a threshold breach by sending a breach trap to NNM, where the trap will display as an
alarm in the NNM alarm browser. The optional thresholds sub-package cannot operate unless
the Thresholds Module is installed. If you are not running any version of the Thresholds
Module, Package Manager will install the latest version for you, automatically.

Multiple Entries in dsi_server

Cisco Ping has problems when dsi_server contains multiple entries. This can occur on
stand-alone systems as well as distributed systems. If multiple entries are present, you will
see error messages when you load collection policy data. To avoid this problem, make sure
there is one distinct host_name in dsi_server. Follow these steps:

1 Determine whether dsi_server contains one or multiple entries:
isql -Usa -P
use dpipe_db
go
select distinct host name from dsi_server
go

2 Ifone host name is returned, everything is fine. If multiple entries are returned, set all of
them to the same value:

update dsi_server set host name = ‘host name’
go

If your system is distributed, substitute the central server host_name from dsi_server for
host_name.
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After installation, check dsi_ping_collection_policy:

isql -Usa -P

use dpipe_db

go

select * from dsi_ping collection policy

If one record is returned, everything is fine.

Installing Cisco Ping

Task 1:

The New Install

Perform the following tasks to install Cisco Ping:

Task 1: Stop OVPI Timer and extract packages from the report pack CD

Task 2: If you are running version 2.2 or earlier of the Interface Discover Datapipe,
remove it

Task 3: Install these packages simultaneously:
— Cisco_Ping
— Cisco_Ping_Thresholds
— Cisco_Ping_Demo (optional)
— Interface Discovery Datapipe 2.4
or
— UPGRADE_IFEntry_Disc_Datapipe_to_24
— Interface Reporting ifEntry Datapipe 2.4
or

— UPGRADE_IRifEntry_Datapipe_to_24

Stop OVPI Timer and extract packages from the report pack CD

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD. On Windows, a Main Menu displays automatically; on UNIX,
mount the CD if the CD does not mount automatically, navigate to the top level directory
on the CD, and run the . /setup command.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

19



20

Task 2:

Task 3:

After the copy to the Package directory is complete, you can navigate to the Packages
directory to see the results. Under the Ping_MIB folder you will see the following folders:

e C(Cisco Ping

e (Cisco Ping Thresholds

e Cisco Ping Demo

e UPGRADE_Ping MIB_to_41

Ignore the upgrade package. Installing the demo package is optional. You may install the
demo package by itself, with no other packages, or you may install the demo package along
with everything else.

Uninstall the Interface Discovery Datapipe

If you are running version 2.2 or earlier of the Interface Discover Datapipe, remove it.
1 Click Next. The Package Location window opens.

Click Uninstall.

Click Next. The Report Undeployment window opens.

Click Next. The Package Selection window opens.

O A WO N

Click the check box next to the following packages:
IR_ifEntry_Datapipe
IFEntry_Disc_Datapipe

6  Click Next. The Selection Summary window opens.

7 Click Uninstall. The Progress window opens and the removal begins. When the removal
finishes, a package removal complete message appears.

8 Click Done to return to the Management Console.

Install Cisco Ping and associated datapipes; restart OVPI Timer

1 Start Package Manager, if it is not already started. The Package Manager welcome
window opens.

2 Click Next. The Package Location window opens.
Click Install.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the OVPI Application Server.

5 Click Next. The Package Selection window opens.

6  Click the check box next to the following packages:
Cisco_Ping 4.1
Cisco_Ping_Thresholds
Cisco_Ping_Demo

IRifEntry_Datapipe 2.4 or
UPGRADE_IRifEntry_Datapipe_to_24

IFEntry_Disc_Datapipe 2.2 or
UPGRADE _IFEntry_Disc_Datapipe_to_24
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7  Click Next. The Type Discovery window opens; accept the default.
8 Click Next. The Selection Summary window opens.

9  Click Install. The Installation Progress window opens and the install begins. When the
install completes, a package install complete message appears.

10 Click Done.
11 Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

Before reports can be viewed, they must be deployed. When you installed the Cisco Ping
Report Pack, you enabled the Deploy Reports option. As a result, the reports in this package
were deployed to the OVPI Application Server. Once reports reside on the OVPI Application
Server, you have two ways to view them:

e QVPI client applications
e Web browser

If the OVPI client applications are installed on the user’s system, the user has access to
Report Viewer, Report Builder, and the Management Console. If the client components are not
installed on the user’s system, the user will need a web browser to view reports.

For more information about the client applications refer to the OVPI Installation Guide. For
more information about the Management Console, including how to use the Object/Property
Management view to launch reports specific to a selected object, see the OVPI Administration
Guide.

Package Removal

The New Install

If you remove a report pack, the associated tables and all the data in those tables will be
deleted. If you want to preserve the data in those tables, archive the data before removing the
package.

Follow these steps to remove Cisco Ping.
1 Log in to the system. On UNIX systems, log in as root.
2  Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:
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a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeployment window opens.
Click Next. The Package Selection window opens.

0 N o0 0 AW

Click the check box next to the following packages:
Cisco_Ping
Cisco_Ping_Thresholds (if installed)
Cisco_Ping_Demo (if installed)

9  Click Next. The Selection Summary window opens.

10 Click Uninstall. The Progress window opens and removal begins. When removal finishes, a

package removal complete message appears.
11 Click Done.
12 Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Action Poller User Interface

This chapter covers the following topics:

¢ Launching the Action Poller User Interface
¢ Defining node pairs

e MiIBlet groups

e Assigning instances to nodes

e Modifying parameter sets

e Exiting the interface

Launching the Interface

The Action Poller User Interface resides in the $SDPIPE_HOME/bin directory. To invoke the
interface, type the following command at the command prompt:

Windows: action_config
UNIX: action _config.sh

The Configure Action Poller window opens. If any collection group, including the default Cisco
Collection, has already been defined, it will appear in this window.

To add a new collection group, click New. To modify an existing collection group definition,
highlight the collection you want to modify and click Modify. The New Action Collection Group
window opens. Follow these steps to define a collection group:

1 Enter the collection group name in the Collection Group field. If you are modifying an
existing collection group definition, the name is displayed in the Collection Group field
and the field is grayed out.

2 After the configuration is complete, enter the name of the host on which the Action Poller
is to run in the Poller Name field.

3 After the new or modified collection is finished, click Save and then click Node Pairs to
open the Node Pair Properties window.

The Action Poller can be configured for distributed polling. For example, you can define
collection group_1 to run on poller A, collection group_2 to run on poller B, and so on. During
the initial configuration, you can leave the Poller Name set to the value of hostname.
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Defining Node Pairs

Highlight any node pair on the Node Pair Properties screen and click Remove to modify the
list of current node pairs assigned to the collection. You may also remove all node pairs.
Clicking Add opens the Add Node Pairs window.

All nodes that are known to OVPI appear in the Available Nodes list box. If the nodes you
want to select are not listed, use Polling Policy Manager to add them and perform a type
discovery from the command prompt using the command: trend_discover -t

Follow these steps to add a new node pair to the collection group:

1

From the Add Node Pairs window, highlight one node that is to be a source node in the

Source Nodes list box. The source node must be a Cisco Router capable of performing an
SNMP set.

Click Make Source to assign the node to the Source Node text box.
Select one node that is to be a destination node from the Destination Nodes list box.

Click Make Destination to assign the node to the Destination Node list box. You can select
several destination nodes for a single Source Node to quickly make node pairs using the
same Source Node.

Click Make Pairs to pair the selected source node with each node that is listed in the
Destination Nodes list box.

The node pairs you define are added to the New Node Pairs list box at the bottom of the
window. The same node can be the source node of one or more pairs and the destination
node of one or more pairs. Each distinct pair of nodes can be added only once per
collection. If you want to collect data from different interfaces on the nodes, set up a new
collection with the same pair of nodes.

If you want to remove a node pair from the new node pairs list box, highlight the node pair
and click Remove Node Pair. The selected pair is removed from the Source-Destination list.

Continue to create as many node pairs as you want to assign to this particular collection
group. When you finish, click Add Node Pairs. To exit, click Close.

MIBlet Groups

A MIBlet group is a named set of MIBlets that you want to collect as a group at a source or
destination node. The Cisco Ping Report Pack always uses the Cisco collection MIBlet and
cannot be modified. This group comprises the following two MIBlets:

interface_rtd_png_

xcpu_util_rtd_png_

These MIBlets correspond to the following standard OVPI MIBlets:

interface-reporting_basic_interface_info

cisco_system
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Assigning Instances to Nodes

Use the Node Pair Properties window to assign the appropriate instance to the source and
destination nodes of each node pair you defined. Multiple instances of MIBlet objects can be
collected from a node depending on the nature of the MIBlet. An instance corresponds to a
unique interface on the node. For example, a separate instance of the

interface_reporting basic_interface_info MIBlet is collected for each interface on a node.

Other MIBlets, such as the cisco_system MIBlet, are collected at the node level, rather than
interface level, and return a single set of values for the node. Data that is interface-specific
will not be collected if an instance has not been assigned.

Follow these steps to assign source and destination collection instances for each node pair:
1 Highlight a node pair in the list box.

2 The MIB-2 Interface Source and Destination instances are initially set to NULL,
indicating that the MIBlet instances to be collected for the source and destination nodes
have not been assigned yet.

3 The instances of the selected MIBlet that can be collected for the source and destination
nodes of the selected pair appear in the Source MIBlet Instances and Destination MIBlet
Instances list boxes, respectively.

) Instance data is inherited from the GENMIB2IF Datapipe or the Interface
Discovery Datapipe. Unless one of these datapipes has collected at least two
poll cycles of data, the list boxes will contain no instances. You may also
import property information, in batch fashion, to add and modify node pair
information.

4  Select the source instance to be collected by clicking the instance listed in the Source Node
Instances list box.

5 Click Assign Source. Note that the selected instance is displayed in the Src Inst column of
the Source and Destination Instance Info list box.

6  Select the destination instance to be collected by clicking the instance listed in the
Destination Node Instances list box.

7 Click Assign Destination Instance.

8 Repeat this procedure to assign the appropriate source and destination instance of each
MIBIlet associated with each node pair you have assigned to this collection group.

9 Click Save when finished.

Moditying Parameter Sets

To modify parameter sets, click Parameter Sets on the Node Pair Properties window and
perform any of these tasks:

e Modify an existing parameter set
e C(Create a new parameter set

e Remove a parameter set
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You may assign the parameter set to an individual node pair or all node pairs. Close the
window when finished by clicking Close.

The following table defines each parameter and indicates what you can specify.

Parameter Description

Packet Count Number of packets to send during each ping
action. Specify from 1 to 2147483647 (2 GB).

Packet Size Number of bytes in each packet. Specify from 1 to
2147483647 (2 GB).

Packet Timeout Milliseconds to wait for a reply from the

destination node. Specify from 0 to 3600000.

Delay Milliseconds to wait between ping actions. Specify
from 0 to 3600000.

Exiting the Interface

You can terminate the interface in either of these ways:
e (Click Close on the initial collection window.
e Select File > Exit.

Any specifications you have made up to that point will be saved as part of the current
collection group.
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5 Contiguration Options

This chapter provides information about the following configuration options:

Configuring servers in a distributed system
Provisioning the property table
Action Poller command line options

Changing the collection interval

Configuring Servers in a Distributed System

If you intend to run Cisco Ping in a distributed system, you had to install the report pack on
the central server and on each satellite server. Now that installation is complete, perform the
following tasks:

Configure the central server.

Configure the satellite server(s).

Configuring the Central Server

Task 1:

To configure the central server, perform the following tasks:

Task 1: Register the satellite server by setting the database role
Task 2: Enable LIR

Task 3: Add LIR mappings

Task 4: Verify the automatically generated copy policies

Task 5: Delete LIR mappings for rate tables

Task 6: Modify the trendtimer. sched file

Register the satellite server by setting the database role

1

O A W N

Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the database system.

Click Database Properties.

From the Database Role list, select the Satellite Server role.
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Task 2:

Task 3:

Task 4:

6 Enter any information necessary to configure the Satellite Server role.

To add a new database reference, you can use the Add Database Reference Wizard in the
System and Network Administration application.

Enable LIR

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.
Click LIR Configuration.

Select the LIR enabled check box.

o A W N

Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Click Add Mapping.

From the Select Satellite Server list, select a satellite server to which to add a mapping.
Select the Category data table option.

Select Cisco Ping from the drop down list.
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Select the rate data type.
Click Add to List.

R R —
= o

If you want to add additional LIR mappings, click Add to list and repeat step 6 through
step 10.

12 Click OK.
13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that
you add. The data type selected when adding an LIR mapping (in step 9 above) determines
the type of data copied (defined in the generated copy policy). The type of data copied (defined
in the generated copy policy) is one greater than the data type selected in the LIR mapping.
For example, if you select an hourly data type, you will generate a daily data copy policy.

Verify the automatically generated copy policies

Verify that a copy policy has been generated for the following tables and that the copy type is
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.
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3 Find the following tables and verify the copy type is set to Property and Data for each
table:

e RPing MIB_base
e SHcisco_ping_rtd_
If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3  Select a satellite server from the pull down list. This is the satellite server from which
data is copied to the central server.

4 Select Single Table and select the table from the pull down list.
5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7  Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can
modify it by clicking Back.

9  Click Finish.

10 Repeat step 4 - step 9 for all missing tables.

If the copy type is not set to Property and Data, do the following:
1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5:  Delete LIR Mappings for the RPing_MIB_base rate table
Delete the LIR mappings for RPing MIB_base (the data is being copied to the central server).
1 Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Unselect the Rate check box for Kisco_ping_rtd_.
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Click Apply.

Task 6:  Modify the trendtimer.sched file

The trendtimer. sched file is found in the {DPIPE HOME}/1ib/ directory where
{DPIPE HOME} is the directory in which OVPI is installed.

Make the following change to this file:
¢ Find and comment out the following line:

1:00+40 - - {DPIPE HOME}/bin/trend proc -f {DPIPE HOME}/scripts/Ping MIB Sum.pro
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Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE HOME}/lib/trendtimer.sched file (wWhere {DPIPE HOME} is the
directory in which OVPI is installed) by switching off interface aggregations above the
hourly level.

¢ Find and comment out the following line:

24:0043:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/Ping MIB Daily.pro

2 Modify the {DPIPE HOME}/scripts/Ping MIB_Sum.pro file (where {DPIPE HOME} is
the directory in which OVPI is installed) by enabling the trendcopy commands to push
data to the central server. Uncomment all trendcopy commands.

3 Make sure that the system clock on each satellite server is synchronized with the system
clock on the central server.

4 Verify that you do not have servers polling the same device.

Provisioning the Property Table

Provisioning the property table is optional. If you want to aggregate data by customer or by
region, or change default threshold settings, provisioning is mandatory. If you are a service
provider and you want to share your reports with customers, provisioning is mandatory.
Threshold values are already defaulted, so provisioning those values is necessary only if you
want to modify the default.

If you do not want to use the Action Poller User Interface to enter node pairs, consider using
the property provisioning mechanism. As the property table is provisioned, any node pairs
that already exist will have customer and threshold information updated. If the node pair
does not exist, it will be created. You should use the interface to delete node pairs.

) If you do not provision the property table, the term unassigned will appear in any list of
customers or regions.

This section covers the following topics:
e K IFEntry_Disc table

e action_property_table file

¢ Format of the import file

e Changing defaults

e Initializing property tables

K_IFEntry_Disc Table

The Cisco Ping Report Pack looks for the K_IFEntry_Disc property table. This table is created
by the Interface Discovery Datapipe. However, you are not required to use this particular
property table or the Interface Discovery Datapipe. If desired, a different property table from
another report pack or datapipe can be used instead.
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The Cisco Ping Report Pack can inherit interface information from the GENMIB2IF_ifentry
Datapipe. If that is what you want to happen, the correct name of the property table to place
in the action_property_table file is K_GENMIB2IF_ifentry. After the Action Poller user
interface has launched, only interfaces that have been discovered, and interfaces that have
collected interface data, will display node instance information.

action_property_table

The Cisco Ping Report Pack will look for the action_property_table file in the
{DPIPE_HOME}\OVPI\1ib directory. The contents of the action_property_table file must
contain the exact name of the correct property table. Make sure the name for the
action_property_table file does not include a file extension such as . txt.

Format of the Import File

While interface instance information can be inherited from the Interface Discovery Datapipe,
the following properties must be imported manually using the provisioning interface:

e Customer
e Region
¢ Round Trip Time Threshold Values
e Packet Delivery Ratio Threshold Values
e Interface Utilization Threshold Values
e Interface CPU Utilization Values
To import this information, create a flat file that contains property information and then
import the file. Follow these steps:
1 Create a property import file using the format described below.
2 Give the file this name: Ping MIB_ Property.dat
3 Place the file in the following directory:
{DPIPE_HOME} /Packages/PING_MIB/Ping MIB.ap/PropertyData

The Ping_ MIB_Property.dat file serves as a record of “node ping pairs” currently associated
with property data. If you wish to add node ping pairs, modify this file and save it to the same
directory specified above. The process runs daily and will not affect existing property values.
Be aware that duplicate node ping pairs may cause undesirable results in the assignment of
property data values.

Your property import file is a tab-delimited file. There are no column headings. When you
create it, be sure to include all the columns listed in the table below, and be sure the sequence
of your columns left to right follows the sequence in the table top to bottom.

Seq | Column Name Description

1 src_rtr_name Source node name

2 src_cpu_instance CPU instance for the source node
3 src_if instance Source node interface instance
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Seq |Column Name Description

4 dst_rtr_name Destination node name

5 dst_cpu_instance CPU instance for the destination node

6 dst_if instance Destination node interface instance

7 cust_id Unique integer value for each customer

8 customer_name Customer name associated with cust_id

9 region_id Unique integer value for each region

10 region_name Region name associated with region_id
11 rtt_threshold Round trip time threshold in milliseconds
12 discard_threshold Packet discard percentage (0-100) threshold
13 interface_threshold | Interface utilization threshold

14 cpu_threshold CPU threshold

If you are unsure of the format or if the import fails, consider exporting existing property
information from OVPI. Edit the file exported by OVPI, then re-import the updated file.

Changing Defaults Related to Property Import

The default directory for property data files, the location where the import utility will look for
your edited files, is specified by the SourceDirectory path. This path appears in the following
TEEL file:

Ping_MIB_Property.teel

If you are changing the default directory before you install the Cisco Ping Report Pack, you
can locate the TEEL files in the Ping_MIB. ap directory. If you want to change the default
directory after running Package Manager, you must change the path information in two
directories:

® Ping MIB.ap

e {DPIPE_HOME}/lib

SourceDisposition

The default for SourceDisposition is keep. Keeping the existing file in place allows the
administrator to identify existing ping pairs that are already provisioned. The disposition of
this file is determined by a directive in the Ping_MIB_Property. teel configuration file. If
desired, you may elect to have the file moved or deleted.

SourceDirectory

To change the SourceDirectory, do the following:
1 Create the new source directory.

2 Navigate to the appropriate directory (see the discussion in the preceding section about
which directories are involved) and open the directory.
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3 Double-click the Ping MIB_Property.teel file.
4 Locate the SourceDirectory default path. (The line beginning with sourcebirectory = )

5 Change the path, replacing the existing path with the complete path name to the new
directory; begin the new path name just after the equals sign ( =).

) Leave the file filter as specified in the original SourceDirectory.

Export Directory

To change the default export directory, modify the export data process file. If you are making
this change before you install the package, you have to make this modification once, in the
Ping_MIB. ap directory. If you are making this change after you run Package Manager, you
must make this modification in two places:

® Ping MIB.ap

e (DPIPE_HOME}/scripts

Follow these steps to change the default export directory:

1 Inthe Ping_MIB.ap directory double-click the Ping MIB_exportdata.pro file.

2 Locate the three trend_export statements; beginning at the bracket after the -o, replace
the existing path with the complete path to the new directory.

3 Only if necessary, that is, only if you have already installed this package, navigate to the
{DPIPE_HOME} /scripts directory and make the same changes you made to
Ping_MIB_exportdata.pro.

Initializing Property Tables

You must initialize the property tables only if you are not already collecting data from the
Interface Reporting Basic Info MIBlet and the Cisco System MIBlet. The Action Poller UI will
show instance information only if the property table has been initialized. To initialize the
property information, create a dummy poll that collects an instance of the designated MIBlets
from each interface on the nodes that you want to participate in Action Poller collections. The
easiest way to do this is to perform the following steps:

) Unless you are adding new nodes to a collection group, you must initialize the property tables
with the appropriate MIBlet instances for each new node that you add.

1 Using the OVPI Polling Policy Manager, set up a view that contains all nodes that are to
participate in Action Poller collections.

2 Set up a dummy polling policy for that view.
3 Invoke the mw_collect utility from the command prompt with the following command:
mw_collect -i 15
) Il)%slli)i;ce “15” with the polling interval you chose when you created the collection

4  Deactivate the dummy polling policy after the mw_collect utility has completed the poll.
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Action Poller Command Line Options

You can invoke the Action Poller from the command line or have trendtimer invoke it through
an entry in the trendtimer. sched file. The command has the following syntax:

action

[-c child processes]
[-d debug level]
(-h]

-i polling interval
[-p port]

[-r retries]

[-s round factor]
[-t timeout]

[-V]

The action command has the following options:

-C

-h

-i

P

-r

Specifies the number of concurrent child action poller processes
to run. The Action poller starts one child process for each node
pair. The processing power of the host determines the value
you specify for this option. The default is 20.

Debug level. Valid values are 0, 1, 2, and 3. The higher the
number, the more detailed the debug output. The default is O,
which means no debug output. Debug output is written to the
standard out. Keep in mind that any value other than 0 will
cause additional overhead.

Displays the command line options (help).

Polling interval. Each collection group that has the specified
polling interval will be collected during this invocation of the
Action poller.

Port number for SNMP sessions. The default is 161.

The number of collection retries to attempt for each SNMP
session. The default is -1, which means the default number of
tries configured for SNMP.

This option rounds off the collection time (ta_period). If the
Action poller kicks off a collection at 3:07, and if you are using
the default collection option of 300 seconds (5 minutes), the
actual ta_period value for the collection will be recorded as
3:05.

The collection timeout, in seconds, for SNMP sessions. The
default is -1, which means the default timeout configured for
SNMP.

Displays the version stamp for action.
This option is in UPPERCASE.

Chapter 5



Changing the Collection Interval

When you install the Cisco Ping Report Pack, the following entry is placed in the
trendtimer.sched file:

15 - - {DPIPE_HOME}/trend_proc -f {DPIPE_HOME}/scripts/Ping MIB_poll.pro

This statement will execute all Cisco Ping collections every 15 minutes. To change the interval
for the collections from the default, simply change 15 to the desired interval. Here is what a
60-minute interval would look like:

60 - - {DPIPE_HOME}/trend_proc -f {DPIPE_HOME}/scripts/Ping MIB_poll.pro

This change leaves all the node pairs in the same group, but modifies how often the collection
is performed. Do not make any changes through Polling Policy Manager. Currently, all
collections will be executed using the same time interval.
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6 Forms—Configure/Create/Update

This chapter provides samples of the following forms:
¢  Configure Collection Group

e Configure Device Pairs

¢ C(Create Device Pair Parameters

e Update Device Pair Parameters

e Update Threshold Values

Only two forms in this group, the Update Device Pair Thresholds and the Update Threshold
Values are accessible from the Management Console. Both of these forms are context
sensitive, which means that the only nodes you will modify are the nodes you selected before
you launched the form. The other forms must be loaded using Report Builder or Report
Viewer.

To reach the Update Device Pair Parameters form or the Update Threshold Values form, click
the Objects icon on the left side of the Management Console. The Object Management window
opens, showing nodes along the left side of the window and various types of tasks listed down
the right side of the window.

e The Update Device Pair Parameter form is listed under General Tasks.
¢ The Update Threshold Values is listed under Object Specific Tasks.

See below for illustrations of all five forms.
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| c:ovpitpackages’ Ping_MIB'Ping _MIB.ap" Cisco_P I f=i EH

[

inwvent

Cisco Ping
Configure Collection Groups

A collection group containg a list of related Cisco Ping device pairs. This
fortm can e used to create ar update Cisco Fing collection groups. To
add ar remove node pairs into a collection group use the "Cisco Ping
configure Device Pairs" farm.

Available Collection Groups

Group Name Poller Hame Polling Interval
Cisco collection : ovpihpt2 45
Cizco collection? ovpihpts 15
Collection Group Hame Zisco callection
Poller Hame avpihptz
Puolling Interval 14
ik Smpl Zancel
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i C:ovpitpackages',Ping_MIB'Ping_MIB.ap'Cisco_Ping_form: e | |

Cisco Ping [ﬁﬂ

Configure Device Pairs PA——

Ilze this form to add new Cisco Ping device pairs to a Cisco Ping collection group. The new
device pair should he assigned interface and CPU instances and a parameter set. The
"iZigco Ping Collection Groups” form can be used to define new collection groups. Far
creating or updating the device pair parameters, use the "Create Device Pair Parameters”
and "Update Device Pair Parameters” forms, respectively.

Available Device Pairs

Choose for the selected Collection Group

Collection Group

Source Node Destination MNode
Cisco collection ll 156,962 156967
Cisco Ping Source |1 a.6.496.2 ll Cisco Ping Destination Idefault LI
%rc IF Instance IFastEthern etd :] Dst IF Instance IEI j
Src CPUInstance |t Dst CPU Instance J1

Pkt Cnt Pkt Size Pkt Timeout Delay
Src Parameters |1 - I 8 ' 100 _ 2000 _ il

Pkt Cnt Pkt Size Pkt Timeout Delay

Dst Parameters |1 - I ] [ 100 2000 o

8] 4 Apply Cancel

Forms— Configure/Create/Update
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E||E:"-.,nvpi"-.,pal:kages"-.,Ping_MIB"-.,Ping_MIB.ap"-.,Ei'scu;Pilj_lfgq reate_d =10l x|

Cisco Ping (ﬁﬁ]

Create Device Pair Parameters e

LJze this form to create new device pair parameters. MNew parameter_id is automatically assigned for
the newly created row,

parameter_id packet_count packet_size packet_timeout delay
' 1 § 5 B T | ©
2 10 500 3000 50
Packet Count |5 Packet Size |1 00
Packet Timeout |znnu Packet Delay |n
) | aEnly Cancel
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E| C:hovpi'packages’Ping_MIB"Ping_MIB.ap'Cisco_Pin

=10l x|

Cisco Ping
Update Device Pair Parameters

[

inwve

n t

LIse this form to update the device pair parameters. Please note that changing the an existing device
pair paramtere would affect all the existing device pair that use the updated device pair parameters.

parameter_id packet_count packet_size packet_timeout delay
i | [ 5 | [ 100 _ 2000 e
2 10 00 3000 a0
Packet Count |5 Packet Size 100
Packet Timeout  [2000 Packet Delay |0
] | Ampls Cancel

Forms— Configure/Create/Update
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] C:ovpi‘packages’Ping_MIB'Ping_MIB.ap'Cisco_Ping =10 x|
=
& &
Cisco Ping WI
Update Threshold Values inven:t
Uze this form to update wvarious threshold values like Round Trip Time, Dizcard, Interface and CPU Threshold.
Threshold Values
N RTT Discard Interface CPU
Source Destination Sample ID
P Threshold Threshold Threshold Threshold
default ] 1,000.00 5.00 S0.00 Fo.00
16.6.96.2 15.6.96.7 1 1,000.00 5.00 S0.00 Fo.oo
165.6.96.2 15.6.96 .41 2 1,000.00 5.00 S0.00 Fo.ao
16.6.96.7 15.0.152 .2 3 1,000.00 5.00 S0.00 Fo.oo
Source IdeTaurt
Destination |
Sample ID In
RTT Threshold |1 000,00
Digcard Threshold |5_|:||:|
CPU Threshold |s0.00
Interface Threshold I?D_DD
-
Rl | ;I_I
2k apply | Cancel |
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7 Worst Performing Node Pairs

The Worst Performing Pairs report looks at yesterday’s activity and ranks node pairs in two
ways:

¢ Node pairs ranked by worst round trip time
¢ Node pairs ranked by worst packet delivery ratio

You may investigate any node pair in more detail by drilling down to yesterday’s hourly data
in the tabbed graphs and finding out exactly when RTT went up, or when the delivery ratio
went down, and whether these events took place when utilization was high or when
utilization was low.

The tabbed graphs track these metrics:

e Average hourly round trip time

e Hourly packet delivery ratio

e Source CPU utilization and destination CPU utilization

e  Source interface utilization and destination interface utilization

RTT is measured in milliseconds; the delivery ratio is a percentage. A sample report follows.
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Worst Performing Node Pairs

The Warst Pedforming Mode Pairs Report prowides separate charks ranking the wwarst pedforming node pairs by round trip -
packet deliveny ratio respectively. Drilling down to either chart shows the detailed metrics forthe node pair collected ow
day. Select a customer (lefth and a node pairfright) to get the drill dowen information.

Worst Performing Hode Pairs, Ranked by Round Trip Tin

Customers Hode Pair RTT De
All

Una=signed Customer am=terdam . desktalk .com -* atlanta.desktalk com 127 .00
sanjose. desktalk.com - sydney desktalk.com 19.00

sanjose . desktalk.com -* london.desktalk .com 12.00

sanjose.desktalk .com -* chicago desktalk.com 1&.00

sanjose . desktalk.com - > newyork desktalk com 17.00

sanjose . desktalk .com -* laswegas desktalk .com 15.00

RTT | Delivery | CPU Lttilization | Interface Ltil. |

Average Round Trip Time
amsterdam . desktalk.com -= astlanta.desktalk.com
hion Sep 30 12:00 &l

14610

97 .40

4570

o + + t t + + + + + +
oo:ao 0Z:a0 0400 ag: a0 oS00 10:00 1200 1400 1600 1800 20:00 2z

— Aug. RTT

Wor=t Performing Hode Pairs, Ranked by Packet Delivery Ratio
hdan Sep 30 2002

Hode Pair RTT Delivery Ratio
sanjose . desktalk .com - newyork desktalk . .com 17.00 az. a5
sanjose . desktalk com - london . .desktalk .com 12.00 az.81
sanjose desktalk .com -* chicago desktalk.com 12.00 az. 71
sanjose desktalk.com -* sydney desktalk.com 19.00 92 55
amsterdam.desktalk com -> astlanta . desktalk.com 127.00 Q2 34
sanjose desktalk .com -+ laswvegas . desktalk . .com 15.00 az.14
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8 Daily QuickView/Daily Snapshot

The Daily QuickView provides a rolling daily summary. Constrained by customer, this report
highlights the node pairs with the highest round trip times for any given customer. This is a
rolling summary because it shows you how the baseline average and the F30 forecast are
changing from day to day.

The Daily Snapshot (not illustrated) is a subset of the Daily QuickView, but otherwise the
reports are identical. Open the Daily Snapshot and you will be able to select the node pairs
you want included in the report.

The list of node pairs at the top of the report indicates the average RTT and the delivery ratio.
Select a node pair to display the following graphs:

e Daily RTT and daily delivery ratio
¢ Baseline to F30 comparison for RTT and delivery ratio
e  Hourly metrics for RTT, delivery, CPU utilization, and interface utilization

The QuickView shows latency and reliability metrics side by side. It also provides the context
you need to understand what the latency and reliability data points to. You can see whether
the packet delivery ratio is also affected, and you have the surrounding network in view. As a
result you now know whether poor ping test results are taking place when CPU and interface
utilization are higher than usual, lower than usual, or average.

A sample of the Daily QuickView follows.
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QuickView N

The Quiddfiew Report provides a ralling daily summary of 35th percentile round trip time values, or daily packet deliveny ratio for the
zelected customer(laffl and the node pairright). The Top 10 daily =amples for the zelacded node pair are displayed for the chosen
timeszpan, allowing the BT T Delivery metrics to be visually correlated with the coresponding CPU and inteface utilizations.

Customers Hode Pairs
All zanjose.deddall.com -> lasvagas. deddalk. com
Unassigned Customer zanjose.desktalk.com -= sydney.desdalk.com

sanjose.desktalk.com -* london.desktalk.com
zanjose. desktalk.com -= chicago.desdalk.com
amsterdam.deshtalk.com -= atlanta.desdalk.com

zanjose.desktalk.com -= newnjok. deskdalk.com

RTT | Delivery | RTT:. BL & F30 | Celivery: BL & F30
Round Trip Time - Daily 95th Percentile Baseline & 30-Day Forecast RTT (P95)
sanjose desktalk.com -7 lasvegas desktalk.com sanjose.desktalk.com - laswegas desktalk.com
Fri Sep 13 2002 - hion Sep 30 2002 Fri Sep 13 2002 - Thu Sep 19 2002
26.10 26,60
17.40 £ 1220
870
u]
a Sun Sep 15 Wred Sep 18
Tue Sep 17 Tue Sep 24 Weas:line Delay
o5 of Arg. RTT (Jz0-Day Forecast Delay

RTT | Deliveryl CPU Litilization | Interface LHil.
Top 10 Round Trip Time Samples for Selected Hode Pair

sanjose. desktalk .com - laswegas.deshktalk.com
fon Sep 300 12:00 Ahd

19.00

SEr

0300 0500 a7.o0 0500 11:00 1300 1500 17:00 19:IDI:I 21:00

M avg. RTT
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Daily QuickView, Daily Snapshot
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9 Sample Data in Near Real Time

The Near Real Time report provides access to sample data collected over the last six hours.
This report is available in two formats, QuickView and Snapshot. Use the QuickView when
specific node pairs are not of interest; use the Snapshot when you want to zero in on specific
node pairs.

The NRT QuickView tells you which node pairs are reporting the highest number of threshold
breaches. The selection table lists node pairs, sorted highest count to lowest count. Use this
table to do a quick comparison of SLA breaches to non-SLA breaches. If you see a total that
causes concern, you can drill down on the node pair and take a closer look at:

e RTT over the last six hours

e Delivery ratio over the last six hours
e CPU utilization

e Interface utilization

This closer look will let you see actual breaches as well as near breaches. If the SLA breaches
are low, you should see utilization above the SLA Qualification Threshold; if the SLA breaches
are high, you should see utilization below the SLA Qualification Threshold.

A sample of the Thresholds NRT QuickView follows.
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QuickView - Near Real Time (/n

invent

The Quidfiew Hear Real Time Report displays the 95th percentile round trip time and packet deliveny ratio for the selected customer

(lefty and node pair(right) ower the ower the last six hours period and provides a wisual correlation with the corresponding CPU and
interface utilizations.

Customers Hode Pairs
All zanjose.deshtalk. com -= laswegas.desdalk.com
Unassigned Customer sanjose.desktall. com -= sydney.deskdalk.com

zanjose.deshtalk.com -= london.desktalk.com
zanjose.deshtalk.com -= chicago.desdalk. com
amsterdam.desktalk.com -» atlanta.deddalk.com

sanjose.deshtalk. com -= newno b, desdalk.com

RTT | Delivery |

Round Trip Time for Selected Hode Pair
zanjose . desktalk com - lagvagas desktalk.com
Tue Oct 01 06:52 Phd

2780

15.40

ms

9.20

1200 1230 1300 1330 1400 1430 1500 1530 1600 1630 1700 1730

—Aug. RTT

CPU Litlization | |nterface Liil.

CPU Wtilization for Selected Hode Pair
Tue Oct 01 0652 Phd

M0

.80 1

Percent

3.90 1

|:| n n n n n n n n n n 1
1200 1230 1300 1330 1400 1430 1500 1530 1600 1630 %00 1730 1§00

— CPU Lkilization : sanjose desktalk .com
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Sample Data in Near Real Time
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10 Threshold Daily QuickView

The Threshold Daily QuickView provides a close-up view of yesterday’s performance, showing
which node pairs had the highest number of response time and discard breaches. Like the two
reports discussed in Chapter 8, Daily QuickView/Daily Snapshot, this is a rolling summary
because it calculates the baseline average and the F30 forecast every day and shows how the
baseline average and F30 forecast are changing from day to day.

If you want to see how yesterday’s activity compares to recent activity, look at the RTT and
Delivery graphs. These graphs will tell you whether yesterday’s breach count was an isolated
incident or part of a trend that has been building over time. You will also see how the average
and P95 values compare to the threshold.

The baseline and F30 graphs show whether conditions are getting better or worse. You may
see a steady increase in the F30, a steady decrease, or little change. If you see a decrease in
the F30, then yesterday’s breach activity may be an isolated incident.

The tabbed graph at the bottom provides an hourly analysis of yesterday’s activity and tells
you exactly when performance crossed the threshold, causing a threshold breach to occur. If
these graphs indicate low utilization when the RTT or delivery breach took place, it’s likely
that SLA breaches took place.

A sample of the Threshold Daily QuickView follows.
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Performance Threshold Breaches -- Daily Quickview

O

inwvent

The Performance Thresholds Quiddiew Repart provides a ralling daily summarny of raund trip time walues, or daily padeet deliveny ratio for
the selected customer(lefty and the node paircright). The Top 10 dailw samples for the selected node pair are displayed for the chosen
timespan, allowing the RTT/Delivery metrics to be visually cormelated with the corresponding CPU and interface utilizations. RTT and
Deliwveny metrics are plotted against the provisioned thresholds allowing breaches or nearbreaches to be easily visualized. Fara RTT ar
Deliweny threshold breach to be considered a 'SLA' breach, the correlated CPU and Interface metrics must fall below the provisioned S0&
Qualification Thresholds.

Mode Pairs with the Highest Humber of Breaches

Customers hon Jan 2002007

£Ema . Tot RTT Tot Discard

Trinagy Hode Pairs Breach Breach
sanjose. dedtalk.com -» swdney. desdalk.com u} u]
sanjose. deddalk.com -» london.deskdalk. com a a
sanjoze.desktalk.com - chicago.desktalk.com ul o
sanjose. desidalk.com -> newnotedegtalk.com ul o
sanjose.desktalk.com -= lasvegas. desktalk.com ul u]

RTT l Dielivery I

Round Trip Time - Daiby
sanjose.desktalk.com -> sydney.desktalk.com
Tue Mow 05 2002 - Sun Dec 023 2002

RTT: BL & F30 | Delivery: BL & Fa0 |

Baseline & 30-Day Forecast RTT (P35)
sanjose . desktalk.com -+ sydney desktalk.com
Tue Mow 05 2002 - hdon Mow 11 2002

10,20 420
680 280
g w
E
s b
1.40
0
Tue Sun Sat Fri Thu Tue Sun [u]
NowS Now 10 Now 16 Mow22 Now 28 Dec3 Decd Tue ‘Wed Thu Fri  Sat Mon

How$S Mov Now7 Howd Hovd Mow 11
RTT (35th Percentile)

— RTT (forerage)
— RTT (Threshold)

.Elaseline Celay
DSD-Day Forecast Delay

RTT l Dielivery ] CPU Uilization | Interface L.

Round Trip Time for the Selected Hode Pair
sanjose.desktalk.com -+ sydney desktalk.com
Sun Dec 02 12:00 Al - Sun Dec 02 11:45 P

10,00

7.50

g soo

2.50

1)
sun sun sun Sun Sun Sun Sun Sun Sun Sun Sun

12000 A 0215 A 0430 AR 0545 AR 02:00 AW 11:15 A 0130 PM 03:45 PMW 0500 P 02315 P 10030 PW

—RTT
—RTT Thrashald
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11 Threshold Summaries

If you want to look more closely at breach counts on a customer by customer basis, and see
how SLA breaches compare to non-SLA breaches, use the two threshold summary reports.
These reports rank node pairs by breach count and indicate what your threshold settings are.
The daily version of the report is cumulative for yesterday’s activity, and the monthly version
is cumulative for the last 30 days. Both reports sort node pairs by threshold count, highest to
lowest.

The daily version has an Exception Details table that indicates when each breach took place.
If the node pair recorded 10 breaches yesterday, the Exception Details table will include 10
entries. Each entry in this table will tell you:

e The type of breach that occurred
¢ The average RTT in effect at that time
¢ The packet loss ratio in effect at that time

If the Exception Details table includes one or more SLA breaches, you can see what utilization
levels were in effect when that breach took place by looking at SLA Qualification Details. The
levels you see here will be low compared to the thresholds for CPU and interface utilization.

The monthly version of the report does not provide exception details or the data that justified
triggering an SLA breach. Instead, you have graphs that track increases and decreases in the
total SLA breach count and the total non-SLA breach count for RTT and delivery ratio.

Samples of the Threshold Breaches Summary report (Daily and Monthly) follow.
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Performance Threshold Breaches -- Daily Quickview

invent

The Peformance Thresholds Quidiiew Report provides a rolling daily summany of round trip time values, or daily pachket deliveny ratio for
the selacted customer (left) and the node pairfright). The Top 10 daily samples forthe selected node pair are displayed forthe chosen
timespan, allowing the RTT/Delivery metrics to be wisually correlated with the corresponding CFU and interface utilizations. RTT and
Creliverny metrics are plotted against the prowisioned thresholds allowing breaches or near-breachesto be easzily visualized. Fora RTT ar
Celiveny threshaold breach to be considered a 'SLA' breach, the comrelated CPU and Inteface metrics must fall below the provisioned SLA
Qualification Thresholds.

Mode Pairs with the Highest Humber of Breaches
Thu Dec 19 2002

Customers
e Tot RTT Tot Discard
i Hode Pairs
Trinagy Breach Breach
zanjose. desktalk.com -» sydney. desktalk. com u] n]
zanjose. deshtalk.com - london. deskdalk. com u] u]
zanjose.deshtalk.com -= chicago.deskdalk.com u] u]
zanjose.deshtalk.com -= newnyod.desktalk. com u] u]
sanjose. desitalk.com -» lasvegas. destalk.com u] u]
RTT | Delivery | RTT: BL & F30 | Delivery: BL & F30
Round Trip Time - Daily Baseline & 30-Day Forecast RTT (P95)
zanjose.desktalk.com -7 sydney.desktalk.com zanjose desktalk .com -+ sydney desktalk.com
Tue Mow 05 2002 - Sun Dec 02 2002 Tue Mow 05 2002 - hdon Mow 11 2002
1020 + 420 T
G20 + =80 -
2 + u
E £ ]
0 .
1.40 1
u] t + +
Fri Mow 3 Fri How 22 Fri Dec i o- L
Wed How S Fri NMow3  Sun Mow 10
RTT (85th Percentile)
— RTT (#werage) Wl Easeline Cralay
— RTT (Threshald) DSD-Da'g.r Farecast Delay
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RTT | Deli'-.fer':.-'l CPU tilization | Interface Ltil.

Round Trip Time for the Selected Hode Pair
sanjose desktalk.com -» sydney desktalk.com
Sun Dec 08 12:00 A - Sun Dec 0% 11:45 P

] t t t t t t t t t t t
Q.00 0200 04:00 0800 02:00 10:00 12:00 1400 16:00 12:00 20:00 2200

—RTT
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Performance Threshold Breaches - Monthly Summary

The Pedormance Threshold Breaches Monthly Summarny provides 3 monthly total of threshold breaches for eveny nod

the packet deliveny ratic and round trip time can be configured for each pair.

In addition, the padket deliverny ratio am

compdred against the configurable minimum interface and CFU utilization thresholds to show 3 service lewel agreemn
breach. Crilling doven from the monthly summarny showes daily packet deliverny ratio and round trip time breaches for a:
‘middle tabkle). Mode pairs are constrained by a selectable customer list (top table).

58

Hode Pair

zanjose. desdalk.com -> laswvegas. desktalk.com
sanjose.desktalk.com -= sydney. deskdalk.com
sanjose.desktalk.com -= london.desktalk.com
zanjose. desktalk.com -=» chicago.deskdalk.com

zanjose. desktalk.com - newnod. deshtall. com

Customers
ACme

Trinagy

SLA Breach Count= for Last Month

Now 2002
Tot RTT
SLA_Breach Tot RTT Breach
u} a
u} o
a a
a a
n} o0

Tot Delivery

SLA-Breach
10

[ T
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RTT Breach | packet Delivery ]

Round Trip Time Breaches
zanjose . desktalk.com -* laswegas desktalk.com
For Sat Mow 30 2002

001 1

Tatal

Fri Mow & Tue Now 12 Sat Now 16 ad Mow 20 Sun Mow 24 Tha Mow 28

M Total RTT Mon-SLA-Breaches
Bl Total RTT SLA-Breaches
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|
12 Executive Summary

If your network has users in various regions or users affiliated with various divisions of the
company, or if you are a service provider with customers, you are likely to be interested in
seeing performance aggregated by region, location, or customer. The Executive Summary
meets this need, allowing you to view a “rolled-up” version of performance data.

Instead of looking at performance for a particular node pair, the Executive Summary rolls up
performance for an entire region or an entire customer. Quick comparisons are now easy. The
division with high response time is easy to spot, and the customer with a low packet delivery
ratio is easy to spot.

The Executive Summary gives you an hourly view of the aggregation and a daily view of the
aggregation. The hourly view gives you an hour-by-hour analysis of response time and packet
delivery, while the daily view gives you a day-by-day view. If the hourly graph for yesterday
looks unusual, compare it to the daily. The comparison should provide the evidence you need
to determine whether or not yesterday’s activity was a temporary condition.

The two graphs for RTT, Hourly Aggregate and Daily Aggregate, show the divergence between
average RTT and P95 RTT. As mentioned earlier, the value for P95 is equal to or greater than
95% of the samples for a given day and reflects near-peak usage.

A sample of the Executive Summary follows.
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The Executive Summary Report provides hourly and daily aggregate pedormance of the nebwok across all node pairs ower the last

month, and owver the last day. Select a customer from the table below to view the aggregates of the 95th percentile round trip time and
the padiet deliveny ratio.

Customers
Al
Unazsigned Customer

Daily Aggregate RTT (95th percentile) Daily Aggregate Packet Delivery Ratio
Fri Sep 13 2002 - hon Sep 30 2002 Fri Sep 13 2002 - Mon Sep 30 2002
10760 121.20
80.70 80.890
5380 E0.EOQ
25.80 2020
u] u}
Tue Sep 17 Tue Sep 24 Tue Sep 17 Tue Sep 24
Ml =g RTT (96th Percentile) B Pt Delivery Ratio
Hourly Aggregate RTT (95th percentile) Hourhly Aggregate Packet Delivery Ratio
hion Sep 30 2002 hdon Sep 30 2002
13640 1
85.80 1
102.30 1
T T os7z0d
2 g0 &
[k}
[
3410 1 28.80 ¢
0 + u] t
han 1200 Ak flam 12:00 Ph han 1200 Ak han 12:00 Phi
Forg RTT (85th Percentile]) — Pkt Delivery Ratio
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Executive Summary
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13 Forecasting Future Performance

The forecast report alerts you to node pairs that may be headed for performance problems. It
tells you which node pairs among all node pairs are expected to have the worst performance
30 days from now. Worst can refer to highest round trip time or lowest packet delivery ratio.

The forecast table beneath the customer list provides a list of node pairs and values for the
following metrics:

e 30 day forecast RTT

e Baseline RTT

e 30 day forecast delivery
e Baseline delivery

The 30 day forecast is a projection. Baseline RTT and baseline delivery are averages. If
performance has worsened over the baseline period, the 30 day forecast will be worse than the
baseline average; if performance has improved, the 30 day forecast will be better than the
baseline average.

The graphs below the forecast table do two things. They let you track daily increases and
decreases in P95 values (these are the values responsible for the projection), and they let you
see how the P95 value is diverging from the baseline average on a daily basis.

The value for P95 is equal to or greater than 95% of the samples for a given day. The value for
P95 reflects near-peak usage and functions as a reliable reflection of the conditions the
network is currently accommodating.

A sample forecast report follows.
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Forecast

D

nvent

The Forecast Report provides a3 chart ranking the warst performing pairs by daily round trip time or by total daily packet deliveny ratio, based
on 3 dweek projection extrapolated from G weeks of data.. Crilling down showves the data on which the forecast veas based, at a daily lewvel,
wiith the day-of-week baseline and 30-day forecast values. Select a customer(top table) and a node pairimiddle table), for the drill down
information. (NOTE: The RTT czalculations are based on daily 85th percentile, providing a better basis for planning than either the awerag:

ar the peak)

Customers
Acme

Trinagy

Forecast -- Worst Performing Hode Pairs

J0-Day-Forecast
RTT

Hode Pair
amsterdam desktalk .com - atlanta.deshktalk .com 2971
RTT | Deli'u'er\y'l
Daily 95th Percentile Round Trip Time
amsterdam.desktalk.com -= atlanta.desdalk.com
Tue Mow 05 2002 - Sun Dec 0% 2002
20.10 q
532.40 1
m
2 1
28.70 +
u}
Fri MHow & Fri Mow 22 Fri Dec &

—95th Perzerntile : RTT

Baseline J0-Day-Forecast Baseline
_ _ oo
RTT Delivery Delivery
Bzt O a5 .28 a5 .99 Sun

RTT: BL ws F30

ms

Delivery: BL w= F30
Round Trip Time -- Baseline vs 30-Day Forecast

am=sterdam . desktalk .com -= atlanta desktalk.com
Tue Mow 05 2002 - hon Mow 11 2002

14270

o520

47.80
Thu Mow 7 Sun Mow 10

[ paseline Delay
[Jz0-Day Forecast Delay
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14 MIB Variables and Summaries

This chapter provides a list of the variables that are polled from the following MIBs:
e C(Cisco Ping MIB

e (Cisco System MIBlet

¢ Interface Reporting Basic Info MIBlet

The Cisco Ping MIB contains performance data for pings; the Cisco System MIBlet contains
CPU utilization data; and the Interface Reporting Basic Info MIBlet contains interface
utilization data.
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Cisco Ping MIB

The source MIB is the Cisco-Ping-MIB. The source table is Risco_ping_rtd. The following table
provides a list of variables, with descriptions.

Variable

OID String

Description

avg_rtt

1.3.6.1.4.1.9.9.16.1.1.1.12

Average round trip for all the packets
that have been sent in this sequence.
This object will not be created until the
first ping response in a sequence is
received.

max_rtt

1.3.6.1.4.1.9.9.16.1.1.1.13

Maximum round trip for all the
packets that have been sent in this
sequence. This object will not be
created until the first ping response in
a sequence is received.

min_rtt

1.3.6.1.4.1.99.16.1.1.1.11

Minimum round trip for all the
packets that have been sent in this
sequence. This object will not be
created until the first ping response in
a sequence is received.

packets_received

1.3.6.1.4.1.9.9.16.1.1.1.10

Number of ping packets that were
received from the target in this
sequence.

packets_sent

1.3.6.1.4.1.9.9.16.1.1.1.9

Number of ping packets that were sent
to the target in this sequence.

packet_size

1.3.6.1.4.1.9.9.16.1.1.1.5

Size of ping packets to send to the
target in this sequence. The lower and
upper boundaries of this object depend
on the protocol. An instance of this
object cannot be modified unless the
associated instance of
ciscoPingProtocol has been created (to
allow protocol-specific range checking
on the new value).

cisco_system MIBlet

The source MIBlet is cisco_system. The source table is xcpu_util_rtd_png_.

Variable

OID String

Description

avg_busyl

1.3.6.1.4.1.9.2.1.57

1 minute exponentially-decayed moving
average of the CPU busy percentage.
Changed from INTEGER to Gauge by HP
OpenView.
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inferface-reporting_basic_interface_info MIBlet

The source MIBlet, basic_interface_info
table is interface_rtd_png .

, is a miblet of the MIB-II ifEntry table. The source

Variable OID String Description

ifSpeed 1.3.6.1.2.1.2.2.1.5 Estimate of current bandwidth in bits per
second. If the interface does not vary in
bandwidth, or if an accurate estimate is
not possible, this object should contain
the nominal bandwidth.

ifInOctets 1.3.6.1.2.1.2.2.1.10 Total number of octets received on the
interface, including framing characters.

ifOutOctets 1.3.6.1.2.1.2.2.1.16 Total number of octets transmitted out of
the interface, including framing
characters.

Summaries

Collected data is summarized on an hourly, daily, and monthly basis.

Summary

What It Aggregates

PingDaily_bykey.sum

Hourly data for all device pairs by day and by key.

PingHourly_bykey.sum

Rate data for all device pairs by day and by key.

PingDaily_allpairs.sum

Hourly data for all device pairs by day.

PingHourly_allpairs.sum

Rate data for all device pairs by hour.

PingHourly_allpairs_by_cust_id.sum

Rate data for all device pairs by hour and by
cust_id.

PingDOW_BL_and_FC_bykey.sum

Rate data for all device pairs by day of week and by
key.

MIB Variables and Summaries
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Baseline and Forecast Data

The source table is SD425Dcisco_ping_rtd_SBF_cisco. trendsum calculates the values for the

variables and stores them in this table.

Variable OID String | Description

day_of _week 6 This string value notes the day of the week
for the collected data.

F30avg_rtt 5 30-day forecast average for round trip delay
times.

F30packets_received 3 30-day forecast for packets received.

F30packets_sent 1 30-day forecast for packets sent.

WAVavg_rtt 4 Weighted average for round trip delay times.

WAVpackets_received |2 Weighted average for packets received.

WAVpackets_sent 0 Weighted average for packets sent.
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Glossary

availability

The percentage of time a device has been operational. Identifies device outages as reported
through the sysUpTime variable. Calculated by combining device sysUpTime with interface
ifOperStatus and interface ifLastChange.

avg volume

This metric is found in capacity planning reports. It refers to average daily volume during the
baseline period. F30 Volume is the 30 day forecast for daily volume.

baseline busy hour

The average of 42 busy hour values recorded during the rolling baseline period. This value
appears in the Capacity Planning report as Avg BH Util, or Average Busy Hour Utilization.

busy hour

The one hour of the day when utilization was higher than the other 23 hours in the day. Do
not confuse busy with peak. Busy hour is an average, an average of four samples. Any sample
within that collection of four samples may have been well above or well below the average.
The busy hour average is treated as a persistent event suitable for use in calculations that
project future performance levels.

daily

A view showing daily performance for the previous 30 days, The most recent day in this view
shows performance for yesterday.

day of week

A forecast, derived from baseline data, that correlates growth rate to each day of the week.

device

Any SNMP manageable device.

discard rate

The percentage of packets discarded by the interface. Data about discards is sampled during
each poll cycle (by default this is four times an hour); based on those samples, OVPI calculates
an average and a maximum discard rate.

discard threshold

The point at which an acceptable percentage of discarded traffic becomes an abnormal
percentage and possibly impacts the user experience. If the interface is full duplex, the same
threshold value is applied to both in and out packets separately.
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error rate

The percentage of packets with errors as reported by the interface. Data about errors is
sampled during each poll cycle (by default this is four times an hour); based on those samples,
OVPI calculates an average and a maximum error rate.

error threshold

The point at which an acceptable percentage of errored traffic becomes an abnormal
percentage and possibly impacts the user experience. If the interface is full duplex, the same
threshold value is applied to both in and out packets separately.

F30/F60/F90

The level where utilization (or volume) is expected to be 30, 60, and 90 days from now.
Calculated by applying linear regression to busy hour levels over the baseline period.

group
This value is imported by the provisioning interface. If this value is not provisioned, the
report shows unknown in this field.

growth rate
F30 utilization divided by average busy hour.

hourly

A view showing performance for the last two days and whatever portion of today has elapsed.
The minimum time range is 48 hours; the maximum is 72 hours.

interface

An entry in the SNMP ifTable for of the device. Can represent a physical or logical interface.

monthly

A view showing performance for each month over the last two years. Blank until data
collection has been functioning for at least one month.

region

This value is imported by the provisioning interface. If this value is not provisioned, the
report shows unknown in this field.

response time

Delay within the network management structure, specifically, delay between the datapipe and
the device. If the delay is being caused by the device, then this value may point to device
resource issues.

threshold breach

The line between normal and abnormal performance. When this line is crossed, an exception
is recorded. Every threshold has a default value that is easily changed to reflect individual
needs.



utilization

The total number of octets traversing the interface as a percentage of the total possible
number of octets, using the ifSpeed property. If an interface is full duplex, utilization is
calculated and displayed separately in each direction. Groups of interfaces have their
utilization calculated by taking the total traffic on all administratively up interfaces in the
group and dividing that by the total possible bandwidth for those interfaces. Utilization for a
group of interfaces is more meaningful when all the interfaces in the group use the same
protocol.

utilization threshold

The point at which the number of octets traversing the interface is considered detrimental to
the service level required by network users. In the case of full duplex interfaces, the same
threshold value is applied to both in and out packets separately.
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A Version History

Version Release Date Enhancements
1.0 July 2001 Action Poller User Interface
10 reports:

¢ Executive Summary

¢ Forecast

¢ Worst Performing Pairs

¢ Daily QuickView

e Daily Snapshot

e Threshold Near Real Time QuickView
¢ Threshold Near Real Time Snapshot
e Threshold Daily QuickView

¢ Threshold Summary Daily

¢ Threshold Summary Monthly

2.0 October 2002 new upgrade package:
UPGRADE_Cisco_Ping_10_to_20

3.0 October 2003 new features:

e OVPI 4.6 support

e OVPI Object Manager support
new forms:

e (Configure Collection Group

e Configure Device Pairs

e Create Device Pair Parameters
e Update Device Pair Parameters
e Update Thresholds

new upgrade package:

e UPGRADE_Cisco_Ping 20_to_30.ap

4.0 April 2004 new feature:
e QOVPI 5.0 support

4.0 June 2005 new feature:
OVPI 5.1 support

new upgrade package:
e UPGRADE_Cisco_Ping_to_40.ap
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Version

Release Date

Enhancements

4.1

April 2007

new features:

¢ LIR Configuration (in OVPI 5.2)

¢ Copy Policy Manager (in OVPI 5.2)

¢ Rate data removed from top level table in NRT reports
new upgrade package:

e UPGRADE_Ping MIB_to_41.ap

defect fixes:

e QXCR1000221971

e QXCR1000412603
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B Editing Tables and Graphs

Any table or graph can be viewed in several ways. Although the default view is usually
adequate, you can easily change to a different view. If you are using Report Viewer, right-click
the object to open a list of view options. If you are using the Web Access Server, follow these
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click the Edit icon next to the table or graph.

o O AN

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.
Set Time Period. ..

Change Constraink Yalues. ..
Select Modes|Interfaces. ..

Change Max Rows, .,
Wiew in new Frame

Frint Table. ..

Export Element as CSY, ..
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ies Table ¥iewer

Polled IP QoS Statistics Data - Input

Cver Previous 6 Hours

IpPrecedence Switched Bytes
u] 105,688

o o o o0

GO0

02,234

O L o e L. | B (O T % B
]

Lo B R |

View Options for Graphs

Switched Plis

GYa

o th OO O O O

G622

L I Y o

=10l

Time Period
Tue Ot 29 0700 A
Tue Ot 29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Ot 29 0700 A
Tue Oct29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Oct 29 0700 A
Tue Oct 29 0700 Ah
Tue Ot 29 0645 Ahd
Tue Oct 29 0645 Al
Tue Ot 29 05495 A
Tue Ot 20 06495 Ahd
Tue Oct 29 0645 Al

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

40000 1

22720 7

29540 1

163 60 1

2180 1

0

Sap 17 Sep 21 Sap 25 Sep 28

add Cverlay. .
Remave Overlay

Set Time Period. .,

hange Constraint Yalues. ..

Select Modes)Interfaces, ..

Displayed Data

Grid
Legend
Skyle

. . .

—hange Max Rows. ..

Display Daka Table

Export Element as CSW. ..
Display: Gverlay Data Table
Excport Graph @verlay Data as C54

View in new Frame

Print Graph. ..

Delete Graph
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The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines

Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

Set Time Period. .. 43 s
Change Constraint Yalues. ..

Select Modes)Interfaces. ..

Displayed Data [ % !

Grid k

Legend J /\

Shyle Area

Change Max Rows. .. Stacking Area

Display Dakta Table Bar

Export Element as CSY... Stacking Bar

Display Gwerlay Data Table Pie

Export Graph Overlay Data as C5.., # Flot

Yiew in new Frame Scatter Plot

Prink Sraph. .. AL B S
e B Hi-Lo-Cpen-Close —

—roa  Candle
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

T+

95 Ee0

olure

7170 ¢

Sat Feb 24 06:00 &M EST
Mormal Disconnect (107 j= 74.00

s

04 t L t + t t t t
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected

time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200,00

180.00
120.00
20.00

40.00

Mon 01 Tue 02 iad 02

Ml 2:0q Utilization (H)
I td a3 Utilization (H)
B Ut Threshold
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924.00 -
9,539 .20
7,154.40

4,769 50

Forecast Minutes

2,364 80

Tho 01 Fri 0Z Sat 03 Sun 04 hon 05 Tue 06 ied OF
D=ys Of The Wieek

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.

200.00
160.00
120.00

20.00

40.00

u]
bon 041 Tue 02 ed O3

M =g Utilization (H)
I 1 ax Utilization ¢H)
M Uil Threshald
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

7850 1

6280 1 ﬂ
o)
av0 [E M K

3140 1
16.70 1
u} + t
Mon 01 Tue 02 Wed 03
— fuwrg WMilization (H)
— hax Utilization (H)
— Wtil Threshold
Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

W Under 1 minute

O between 1 and 5 minutes

O petween 5 and 30 minutes

O Betwesn 30 minutes and 2 hours
B Between 2 hours and 12 hours
M Cver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.
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Display Data Table

This option changes a graph into a spreadsheet.

=1k
* Axis I Average I

Tue Feb 19... 0.509

Tue Feb 19... 0.621

Tue Feb 19... 1.026

Tue Feb 19... 0.362

Tue Feb 19... 1.171

Tue Feb 19... 1.051

Tue Feb 19... 0,254

Tue Feb 19... 0.526

Tue Feb 19... 1,433 %

Tue Feb 19... 0.967

Tue Feb 19... 1.471

Tue Feb 19... 1.308

Tue Feb 19... 1.123

Tue Feb 19... n.93

Tue Feb 19... 1.497

Tue Feb 19... 0.506

Tue Feb 19... 0.725

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

=10l x|

Hetwork Response Time
Cizco_04
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Edliting Tables and Graphs
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Index

A
ActionDatapipe, 35

Action Poller
adding a new collection group, 23

changing an existing parameter set, 25
changing the collection interval, 35

command line option, 34
defining node pairs, 24
invoking, 23

node pair properties, 24
removing node pairs, 24

adding a collection group definition, 23

avg volume, 71

B

baseline busy hour, 71
basic_interface_info (MIBlet), 69
busy hour, 71

C
capacity planning, 4, 9

change max rows option, 79
cisco_system MIBlet, 25

Cisco Ping MIB, 5, 9

Cisco System MIBlet, 5, 9

collection group, 25

Configure Collection Group form, 37
Configure Device Pairs form, 37

Copy Policy Manager, 4, 28, 29

Create Device Pair Parameters form, 37

customer-specific reports, 8, 9

D

daily, 71

day of week, 71

demo package, 9, 13, 20
deploying reports, 21

destination MIBlet instance, 25

destination node, 26

device, 71

discard exceptions, 4, 9

discard rate, 71

discard threshold, 71
Display Data Table, 79
displayed data option, 79
distributed systems, 11, 17
dummy polls, 33

error messages, 7, 9

error rate, 72
error threshold, 72

F

F30, 72
F60, 72
F90, 72

forms

G

Configure Collection Group, 37
Configure Device Pairs, 37

Create Device Pair Parameters, 37
Update Device Pair Parameters, 37
Update Threshold Values, 37

grid options, 79

group, 72

group filters, 8, 9

growth rate, 72

H

hourly, 72
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ifInOctets (variable), 69

ifOutOctets (variable), 69

ifSpeed (variable), 69

initializing property tables, 33

interface, 72

interface_rtd_png_, 24

Interface Discovery Datapipe, 17, 20
Interface Reporting Basic Info MIBlet, 5, 9
IR ifEntry Datapipe, 17

L
legend options, 79
LIR Configuration, 4, 28

M

MIBs
Cisco Ping MIB, 5, 9
Cisco System MIBlet, 5, 9
Interface Reporting Basic Info MIBlet, 5, 9

MIB variables
cisco_system MIBlet, 68
Cisco Ping MIB, 68
interface-reporting_basic_interface_info MIBlet,
69

monthly, 72
multiple entries in dsi_server, 18

mw_collect, 33

0

OVPI Timer
starting, 15

P
packet delivery ratios, 6, 9

packets_received, 68
packets_sent, 68

parameters
delay, 26
packet count, 26
packet size, 26
packet timeout, 26

Ping MIB_Property.dat, 31
PingMIB_Thresholds, 14
polling interval, 34
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polling policy, 33
port number, 34

Product Manuals Search (web page), 9

R

remove node pair, 24
report parameters, 8, 9
response time, 72
round trip time, 68

route availability, 7, 9

S
satellite servers, 30
SNMP SET request, 6, 9

source
MIB, 68
table, 70

SourceDirectory path, 33

source instance of each MIBlet, 25
source MIBlet instance, 25

style options for graphs, 79

summaries
PingDaily_allpairs.sum, 69
PingDaily_bykey.sum, 69
PingDOW_BL_and_FC_bykey.sum, 69
PingHourly_allpairs.sum, 69
PingHourly_allpairs_by_cust_id.sum, 69
PingHourly_bykey.sum, 69

system clocks, 30

T

TEEL files, 32

threshold, 72

Threshold Breaches Summary, 55
Threshold Daily QuickView, 53

thresholds
discard, 71
error, 72
Threshold Breaches Summary, 55
Threshold Daily QuickView, 53
Thresholds NRT QuickView, 49
utilization, 73

Thresholds NRT QuickView, 49
trend.log, 7, 9



U

unavailable route, 7, 9

unknown, 30

unsuccessful pings, 6, 9

Update Device Pair Parameters form, 37
Update Threshold Values form, 37
UPGRADE_Ping MIB_to_41, 14

Use Absolute Time, 77

utilization, 73

utilization threshold, 73

\'}

view in new frame, 78

X
xcpu_util_rtd_png_ (MIBlet), 24, 68
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